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General Safety Summary

General Safety Summary
Review the following safety precautions to avoid injury and prevent damage to this product or any products connected to it.

To avoid potential hazards, use this product only as specified.

Only qualified personnel should perform service procedures.

While using this product, you may need to access other parts of a larger system. Read the safety sections of the other
component manuals for warnings and cautions related to operating the system.

To Avoid Fire or Personal Injury
Use Proper Power Cord. Use only the power cord specified for this product and certified for the country of use.

Ground the Product. This product is grounded through the grounding conductor of the power cord. To avoid electric
shock, the grounding conductor must be connected to earth ground. Before making connections to the input or output
terminals of the product, ensure that the product is properly grounded.

Observe All Terminal Ratings. To avoid fire or shock hazard, observe all ratings and markings on the product. Consult
the product manual for further ratings information before making connections to the product.

The inputs are not rated for connection to mains or Category II, III, or IV circuits.

Power Disconnect. The power cord disconnects the product from the power source. Do not block the power cord; it
must remain accessible to the user at all times.

Do Not Operate Without Covers. Do not operate this product with covers or panels removed.

Do Not Operate With Suspected Failures. If you suspect that there is damage to this product, have it inspected by
qualified service personnel.

Avoid Exposed Circuitry. Do not touch exposed connections and components when power is present.

Replace Batteries Properly. Replace batteries only with the specified type and rating.

Use Proper Fuse. Use only the fuse type and rating specified for this product.

Do Not Operate in Wet/Damp Conditions.

Do Not Operate in an Explosive Atmosphere.

Keep Product Surfaces Clean and Dry.
Provide Proper Ventilation. Refer to the manual’s installation instructions for details on installing the product so it has
proper ventilation.
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General Safety Summary

Terms in this Manual
These terms may appear in this manual:

WARNING. Warning statements identify conditions or practices that could result in injury or loss of life.

CAUTION. Caution statements identify conditions or practices that could result in damage to this product or other property.

Symbols and Terms on the Product
These terms may appear on the product:

DANGER indicates an injury hazard immediately accessible as you read the marking.

WARNING indicates an injury hazard not immediately accessible as you read the marking.

CAUTION indicates a hazard to property including the product.

The following symbol(s) may appear on the product:
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Environmental Considerations

Environmental Considerations
This section provides information about the environmental impact of the product.

Product End-of-Life Handling
Observe the following guidelines when recycling an instrument or component:

Equipment Recycling. Production of this equipment required the extraction and use of natural resources. The
equipment may contain substances that could be harmful to the environment or human health if improperly handled at the
product’s end of life. In order to avoid release of such substances into the environment and to reduce the use of natural
resources, we encourage you to recycle this product in an appropriate system that will ensure that most of the materials are
reused or recycled appropriately.

The symbol shown below indicates that this product complies with the European Union’s requirements according to Directive
2002/96/EC on waste electrical and electronic equipment (WEEE). For information about recycling options, check the
Support/Service section of the Tektronix Web site (www.tektronix.com).

Mercury Notification. This product uses an LCD backlight lamp that contains mercury. Disposal may be regulated due
to environmental considerations. Please contact your local authorities or, within the United States, the Electronics Industries
Alliance (www.eiae.org) for disposal or recycling information.

Restriction of Hazardous Substances
This product has been classified as Monitoring and Control equipment, and is outside the scope of the 2002/95/EC RoHS
Directive. This product is known to contain lead, cadmium, mercury, and hexavalent chromium.
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Preface

Preface
This manual describes the installation and basic operation of the RSA6100A Series of real-time spectrum analyzers. For
more detailed information, see the online help for your instrument.

Key Features
The RSA6100A Series is a family of high-performance real-time spectrum analyzers. Key features include:

Easy event-based capture of transient RF signals by triggering on changes in the frequency domain using
Tektronix-exclusive Frequency Mask Triggering

Digital Phosphor Spectrum analysis, which greatly reduces the amount of time to recognize and identify a fault

Seamless capture of signals in up to 110 MHz spans

Multi-domain displays that provide an intuitive understanding of time-varying RF signals

Display of signal instabilities and transients that are difficult or impossible for other signal analyzers to catch

Search compares Spectrum traces to user-defined limit lines and masks for pass/fail testing

Documentation
The following documentation is available with your Tektronix RSA6100A Series Spectrum Analyzer. For the most current
documentation, refer to the Tektronix Web site.

To read about Use these documents
Installation and operation (overviews) RSA6100A Series Real-Time Spectrum Analyzers Quick Start User

Manual. The quick start user manual contains general information about
how to put your instrument into service, guides to user interface controls,
and application examples.

In-depth operation and user interface help RSA6100A Series Real-Time Spectrum Analyzers Online help. The online
help contains detailed information about how to operate the instrument.

Programming Commands RSA6100A Series Real-Time Spectrum Analyzers Programer Manual. The
programming commands for the RSA6100A Series are located in a PDF
file located on the RSA6100A hard disk and on the product software CD.

Specifications and Performance Verification RSA6100A Series Real-Time Spectrum Analyzers Specifications and
Performance Verification Manual. This manual contains the instrument
specifications and a procedure to check instrument performance against
warranted characteristics. This manual is in a PDF file located on the
RSA6100A hard disk and on the product software CD.

User Service RSA6100A Series Real-Time Spectrum Analyzers Service Manual.
An optional manual that provides a list of replaceable parts, care and
maintenance information, and information for servicing the instrument to
the module level.
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Preface

Software Upgrades
Software upgrades are available. Software upgrades become operational only after you enter a valid option key for the
specific spectrum analyzer model and serial number.

To check for upgrades:

1. Go to the Tektronix Web site (www.tektronix.com).

2. Select Software and Drivers to link to the Software and Firmware Finder Web page.

3. Enter the product name (RSA6100A) to find available software upgrades.

Conventions Used in This Manual
The following icons are used throughout this manual:

Sequence
Step

Front panel
power

Connect
power

Network PS2 SVGA USB
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Installation

Installation

Before Installation
Unpack the instrument, and check that you received all items listed as Standard Accessories. Optional accessories and
instrument options are also listed in this section. Check the Tektronix Web site (www.tektronix.com) for the most current
information.

Standard Accessories
Your instrument comes with the following accessories: quick start user manual (languages are listed below), programmer
manual (on CD), specifications and performance verification manual (on CD), power cord, BNC-N adapter, USB keyboard,
USB mouse, and instrument pouch.

Documents
RSA6100A Series Real-Time Spectrum Analyzers Quick Start User Manual is available in the following languages:

English, Tektronix part number 071-1909-XX.

Simplified Chinese, Tektronix part number 071-1910-XX.

Japanese , Tektronix part number 071-1911-XX.

Russian, Tektronix part number 071-1912-XX.

RSA6100A Series Real-Time Spectrum Analyzers Documents CD, Tektronix part number 063-3930-XX. The Documents
CD contains PDF versions of the following manuals:

RSA6100A Series Real-Time Spectrum Analyzers Quick Start User Manual, in English, Japanese, Russian and
Simplified Chinese.

RSA6100A Series Real-Time Spectrum Analyzers Programer Manual., Tektronix part number 071-1913-XX.

RSA6100A Series Real-Time Spectrum Analyzers Specifications and Performance Verification Manual, Tektronix
part number 071-1915-XX.

RSA6100A Series Real-Time Spectrum Analyzers Declassification and Security Instructions, Tektronix part number
071-2056-XX.

Power Cords
The RSA6100A Series Real-Time Spectrum Analyzers are shipped with one of the following power cord options. Power
cords for use in North America are UL listed and CSA certified. Cords for use in areas other than North America are approved
by at least one authority acceptable in the country to which the product is shipped.

International Power Plugs
Opt. A0 - North America power

Opt. A1 - Universal EURO power

RSA6100A Series Quick Start User Manual 1



Installation

Opt. A2 - United Kingdom power

Opt. A3 - Australia power

Opt. A4 - 240 V, North America power

Opt. A5 - Switzerland power

Opt. A6 - Japan power

Opt. A10 - China power

Opt. A11 - India power

Opt. A99 – No power cord

Optional Accessories
RSA6100A Series Real-Time Spectrum Analyzers Service Manual, Tektronix part number 071-1914-XX.

RSA61RHD - Provides an additional removable hard disk drive for use with Option 06

065-0765-XX - Additional removable solid-state hard drive for use with Option 08 (Windows XP and instrument SW
pre-installed)

Options
You can add the following options to your spectrum analyzer:

Option 01 - Adds 10 MHz to 3 GHz Pre-Amplifier

Option 02 - Adds frequency mask triggering and RAM expansion

Option 05 - Adds digital IQ output and 500 MHz analog IF output

Option 06 - Adds a removable hard disk drive (not compatible with Option 07 or Option 08)

Option 07 - Adds a DVD±RW drive, no-cost option (not compatible with Option 06 or Option 08)

Option 08 - Adds a removable solid-state hard drive (not compatible with Option 06 or Option 07)

Option 20 - Adds advanced signal analysis (including pulse measurements)

Option 21 - Adds general-purpose digital modulation analysis

Option 110 - Adds 110 MHz real-time capture bandwidth

Option 1R - Adds Rackmount Kit

2 RSA6100A Series Quick Start User Manual



Installation

Operating Considerations

Power Supply Requirements
Source Voltage and Frequency Power Consumption
100 – 240 VRMS, 50/60 Hz
115 VRMS, 400 Hz

600 W maximum

Environmental Requirements
Characteristic Description
Operating temperature +5 °C to + 50 °C

(+5 °C to +40 °C; when accessing the DVD
drive or optional removable hard-disk drive)

Non-operating temperature -20 °C to +60 °C
Humidity 90% at 30 °C (non-condensing)

80% maximum when accessing the DVD drive
Maximum wet-bulb temperature 29 °C

Altitude:
Operating
Non-operating

Up to 3000 m (9843 ft)
12190 m (40,000 ft)

Cooling clearance
Bottom
Sides and back

20 mm (0.79 in)
50 mm (1.97 in)

CAUTION. To ensure proper cooling, do not operate the instrument on its side. Operate the instrument only when it is resting
on its feet, located on the bottom of the case. Maintain at least 2 inches (5 cm.) clearance around ventilation openings.

WARNING. To avoid personal injury, take extra care when lifting or moving the spectrum analyzer. The instrument is
somewhat heavy and requires extra care when moving it.
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Connecting to the Instrument
Connecting to a Network
Connect your keyboard, mouse, printer, and other accessories to your instrument before applying power. (Accessories with
USB connectors can be connected before or after applying power.)

You can connect your instrument to a
network for printing, file sharing, Internet
access, and other functions. Consult your
network administrator and use the standard
Windows utilities to configure the instrument
for your network.

Quick Tip
If you connect your instrument to a network, you should protect your instrument by using an internet firewall, installing
regular approved operating system updates, and using up-to-date antivirus software.

Powering On the Instrument

4 RSA6100A Series Quick Start User Manual



Installation

Powering Off the Instrument

Removing the Power

Adding an External Monitor
Use the following procedure to add an external monitor for dual monitor configuration. Both the spectrum analyzer and
the second monitor must have the color set to True Color.
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1. Power off the spectrum analyzer and the
external monitor.

2. Connect the external monitor to the
spectrum analyzer.

3. Power on the spectrum analyzer and the
external monitor.
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4. Open the Windows Control Panel.

5. Double-click Intel(R) Extreme Graphics
2 M to open the properties page.

6. Click Intel(R) Dual-display Clone to
show internal screen (Notebook) content
on an external monitor (Monitor).
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7. Adjust the settings as necessary and
then click OK to apply the settings and to
close the properties page.

Adjusting the Windows Display Settings
To change the instrument display settings, use the Intel Graphics Driver instead of the default Windows display properties.
The Intel Graphics Driver provides additional capabilities that are not accessible from the Windows display properties
dialog box.
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1. Open the Windows Control Panel.

2. Double-click Intel(R) Extreme Graphics
2 M to open the properties page.

3. Adjust the settings as necessary.

NOTE. Not all of the selections in the
property page will be available if there is no
external monitor connected to the instrument.

4. Click OK to apply the settings and to
close the properties page.

NOTE. Although it is not recommended, you can attach a second monitor after the spectrum analyzer is powered on;
however, after connecting, you will still need to enable the Extended Desktop from the Intel Extreme Graphics 2M control
panel.
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Inspecting the Instrument
Launch the diagnostics application (Tools > Diagnostics). If failures occur, perform the following steps to get more information
about them. You can also use the following steps as a detailed incoming inspection to verify the functionality of your
instrument. If you want to check the accuracy specifications of your instrument, see the RSA6100A Series Real-Time
Spectrum Analyzers Specifications and Performance Verification Technical Reference manual PDF (part number
071-1915-00) located on the Documents CD.

1. Select Tools > Diagnostics.

2. On the Diagnostics tab, click All
Modules, All Tests.

3. Click Single Test.

4. Click Run.
The instrument will run through
the tests one at a time. A check
mark or X icon will appear to the
right of each check box as that
test is completed. The check icon
means the test was passed. The
X means the test was failed.

5. For tests that require manual
intervention, follow the on-screen
instructions to complete the tests.

NOTE. Select the Diagnostics Failure Information tab to see basic diagnostic failure information. Use the Windows Event
Viewer (a subset of the Administrative tools in the Windows Control Panel) to view failure history and nondiagnostic failures
reported by the application.
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User Maintenance
Cleaning Your Instrument
Clean the exterior surfaces of the chassis with a dry lint-free cloth or a soft-bristle brush. If any dirt remains, use a cloth or
swab dipped in a 75% isopropyl alcohol solution. Use a swab to clean narrow spaces around controls and connectors. Do
not use abrasive compounds on any part of the instrument because they might damage the instrument.

CAUTION. Avoid getting moisture inside the instrument during exterior cleaning; use just enough moisture to dampen the
cloth or swab. Do not wash the front-panel On/Standby switch. Cover the switch while washing the instrument. Use only
deionized or distilled water when cleaning. Use a 75% isopropyl alcohol solution as a cleanser and rinse with deionized
or distilled water. Do not use chemical cleaning agents; they might damage the chassis. Avoid chemicals that contain
benzene, toluene, xylene, acetone, or similar solvents.

CAUTION. To prevent damage to the flat panel display, do not use improper cleaning agents or methods. Avoid using
abrasive cleaners or commercial glass cleaners to clean the display surface. Avoid spraying liquids directly on the display
surface. Avoid scrubbing the display with excessive force.

Clean the display surface by gently rubbing the display with a clean-room wipe. If the display is very dirty, moisten the wipe
with distilled water or a 75% isopropyl alcohol solution and gently rub the display surface. Avoid using excess force; this
might damage the display surface.

Upgrading the Instrument Software
Software upgrades are available from Tektronix. They can either be downloaded from the Tektronix Web site or they can be
ordered from your local Tektronix representative. To add additional software options or features, you will need an option key
from Tektronix. When you receive the software from Tektronix, install it on your instrument. When prompted, enter the option
key, and then follow the online instructions to complete the upgrade.

Returning Your Instrument
If you return your instrument to Tektronix:

Back up any user software on the hard disk. You may need to reinstall the software after your instrument is returned.

When repacking the instrument for shipment, use the original packaging. If the packaging is unavailable or unfit for use,
contact your local Tektronix representative to obtain new packaging.

Seal the shipping carton with an industrial stapler or strapping tape.
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Operation

Getting Acquainted with Your Instrument
Controls and display elements are shown in the following illustrations and tables.

Front Panel Controls
Most front panel controls are shortcuts for opening control panels.

Ref number Item Description Menu Equivalent
1 Media DVD±RW drive, removable hard disk drive, or

removable solid-state hard drive
2 Displays Opens the Displays dialog box to select measurement

displays.
Setup > Displays

3 Settings Opens the Settings control panel for the selected
display.

Setup > Settings

4 Trigger Opens the Trigger control panel. Setup > Trigger
5 Acquire Opens the Acquire control panel. Setup > Acquire
6 Analysis Opens the Analysis control panel. Setup > Analysis
7 Freq Adjusts the measurement frequency. Setup > Analysis >

Frequency tab 2

8 Span (Spectrum) Adjusts the span or frequency range shown in the
Spectrum display. 1

Setup > Settings >
Freq & Span 1 2
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Ref number Item Description Menu Equivalent
9 Amplitude Adjusts the reference level. Setup > Amplitude 2

10 BW (Spectrum) Adjust the resolution bandwidth (RBW). 1 Setup > Settings > BW
tab 1 2

1 Applicable only when the selected display is Spectrum, DPX Spectrum, or Spectrogram.
2 Press and hold for one second to open the associated control panel.

Ref number Item Description Menu Equivalent
11 Tab Moves the cursor to the next entry in the dialog box

or control panel. Same as pressing the Tab key on an
external keyboard.

12 Run (Stop) Push to start and stop acquisitions. Run > Run
13 Markers, Peak Moves the active marker to the maximum peak of the

trace in the selected display. If markers are turned
off, the MR (marker reference) marker will appear at
the maximum peak.

14 Markers, Select Selects the next marker.
15 Markers, Define Opens the Markers control panel.
16 Esc Exits dialog boxes without saving changes.
17 Control knob Changes values in numeric and list controls. Pressing

the knob (clicking it) is the same as pressing the Enter
key on a keyboard.

18 Arrow keys Move the Markers. The Up arrow moves the selected
marker 10 trace points to the right. The down arrow
moves the selected marker 10 trace points to the left.
The left and right arrows move the selected marker to
the next peak. (Turning the knob moves the marker
one trace point left or right.)
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Ref number Item Description Menu Equivalent
19 Keypad Enters values in controls.
20 Enter Completes the data entry in controls. Same as

pressing the Enter key on the keyboard.

Ref number Item Description Menu Equivalent
21 Recall Opens the Recall dialog box. File > Recall...
22 Save Saves working file using the same user selections as

for the previous Save action.
File > Save

23 Touch Screen
On/Off

Turns the touch screen on and off.

24 Help Displays the online help. Help > User Manual
25 Print Opens the Print dialog box. Printouts are a screen

capture of the RSA6100A application window.
File > Print

26 Preset Returns the instrument to its default or preset values.
After a Preset action, the Spectrum Analyzer display
is the only open window.

Setup > Preset
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Front Panel Connectors

Ref number Item Description
1 Trig Out Trigger output connector. 50 Ω, BNC, High > 2.0 V, Low < 0.4 V, (output current 1 mA)
2 Trig In External Trigger input connector, –2.5 V to +2.5 V range, trigger level is user

configurable)
3 USB 1.1 USB 1.1 mouse connector
4 USB 2.0 USB 2.0 connector
5 RF Input RF input connector 50 Ω
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Rear Panel

Ref number Connector, Description
1 AC Input, main power connector
2 GPIB
3 IF output (Option 05)
4, 5 Real Time IQ Out (Option 05)
6 Ref In, reference frequency input
7 Ref Out, reference frequency output
8 Headphone, audio output connector
9 External Trigger 2 Input
10 COM 2, serial port for connecting peripherals
11 VGA, external monitor output (resolution not limited to VGA)
12 PS2 Keyboard input
13 USB2 ports for mouse and other USB2 devices
14 TekLink, reserved for future use
15 +28 VDC Output, (switched)
16 LAN, Ethernet network connector

Interface and Display Elements
Commonly-used buttons and controls are located in the tool bar. Most of the buttons open control panels for changing the
instrument setups. The contents of the control panels vary depending on the selected display. You can also access the
control panels from the front panel buttons or from the keyboard.
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Ref number Item Description
1 Displays Opens the Select Displays dialog box so that you can select measurement

displays.
2 Markers Opens or closes the Marker toolbar at the bottom of the window.
3 Settings Opens the Settings control panel for the selected display. Each display

has its own control panel.
4 Trigger Opens the Trigger control panel so that you can define the trigger settings.
5 Acquire Opens the Acquire control panel so that you can define the acquisition

settings.
6 Analysis Opens the Analysis control panel so that you can define the analysis

settings such as frequency, analysis time, and units.
7 Center Frequency Displays the Center Frequency. To change the value, click the text and use

the front panel knob to dial in a frequency. You can also enter a frequency
with the front panel keypad or use the front panel up and down buttons.

8 Reference Level Displays the reference level. To change the value, click the text and enter
a number from the keypad or use the front panel up and down buttons.

9 Amplitude Opens the Amplitude control panel so that you can define the Reference
Level, configure internal attenuation, and enable/disable the (optional)
Preamplifier.
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Ref number Item Description
10 Replay Runs a new measurement cycle on the existing acquisition data record

using any new settings.
11 Run Starts and stops data acquisitions. When the instrument is acquiring

data, the button label has green lettering. When stopped, the label has
black lettering.
You can specify the run conditions in the Run menu. For example, if
you select Single Sequence in the Run menu, when you click the Run
button, the instrument will run a single measurement cycle and stop. If
you select Continuous, the instrument will run continuously until you stop
the acquisitions.

12 Check Mark indicator The check mark indicator ( ) in the upper, left-hand corner of the display
indicates the display for which the acquisition hardware is optimized.
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Display-Specific Controls
Most displays have commonly-used controls arranged around the graph. They provide quick access to common settings;
the full control set for the display is in the Settings control panel. The following illustration and table show some of the
common icons that appear in most displays.

Table 1: Common Icons
Ref number Control icon Description
1 Drop-down List. Click to select a value from the drop-down

list.
2 Knob. Click anywhere on the icon or on the text readout

to select the control. You can then change the value with
the front panel control knob or arrow keys, or enter a value
from the keypad.

3 6.337μs Italicized numbers. These indicate automatically selected
control values. Several controls in the instrument (for
example, RBW and Analysis Length) allow you to select
an Auto mode. In Auto mode, the instrument software
automatically sets the value. You can change the control
to Manual mode by changing the value. To return to Auto
mode, clear the value, and then press the Enter key.
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Basic Concepts
Real Time Spectrum Analyzers
Tektronix Real-Time spectrum analyzers, such as the RSA6100A Series Spectrum Analyzers, have an optional, patented
frequency mask trigger. The frequency mask trigger allows you to set up a spectral mask to capture a signal when a spectral
anomaly occurs. This allows the real time spectrum analyzer to check 100% of the input signal before acquiring, and
then capture precisely the intermittent RF event of interest.

DPX™ technology allows you to view the RF signal as a live display. You can view very short transient signals, multilevel
signals, and time-varying events.

The RSA6100A Series Spectrum Analyzers allow you to view the captured signals in a wide variety of time-correlated
displays. This is useful for device troubleshooting and signal characterization applications. All of the measurements are
based on the same underlying set of time domain sample data.

Measurement Displays
The RSA6100A window can show one or any combination of general purpose and application-specific displays.

This example shows a single DPX Spectrum
display within the window.
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This example shows the window with two
displays, a Spectrum display and a DPX
spectrum display.
When you have more than one display
open, the display with the check mark icon
has control over the acquisition hardware.
To give a display priority over any others,
click its title bar.

This example shows four displays in the
window.

The acquisition data source can be a live acquisition or a saved acquisition data file. The sharing of acquisition data between
displays allows you to view the same data in multiple ways. For example, you can display a power versus frequency
(spectrum) display and a spectrogram diagram at the same time. Because the data source is shared among the different
displays, the displays are correlated. That is, a point or set of points within one display is associated with a point or set of
points in every other display in the application window.
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Navigating Displays
The RSA6100A uses multiple displays to keep operations simple, and yet provide advanced functionality when needed.
Some of the display categories include:

General Signal Viewing displays. These displays show graphs for basic signal parameters such as amplitude, phase,
and frequency plotted against frequency or time. Examples of these displays include: Spectrum, DPX, Spectrogram,
Time Overview, and Phase vs Time.

General Purpose Digital Modulation displays. These displays show the results of demodulating signals and analyzing
them in multiple domains. Examples of these displays include: Constellation, Symbol Table, and EVM vs Time. These
displays are available with Option 21, General Purpose Modulation Analysis.

General Purpose RF Measurement displays. These displays show the results of automated measurements on RF
signals. Examples of these displays include: ACPR, MCPR, and CCDF.

Pulsed RF displays. These displays show the results of advanced analysis for pulsed RF signals. Examples of
these displays include: Pulse Statistics, Pulse Table, and Pulse Trace. These displays are available with Option 20,
Advanced Signal Analysis.
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Selecting Displays
The spectrum analyzer provides an easy way of selecting displays.

1. Click Displays to open the Select
Displays dialog box.

2. Click the desired application
folder.
The available displays for each
folder are listed in the Available
Displays pane.

3. Click one of the display icons.

4. Click Add (or double-click the
icon) to add the selected display
to the Selected displays list.
Repeat the procedure to add other
displays.

5. Click OK to close the dialog
box. The selected displays will
automatically open.

Quick Tips
Push the Displays button on the front panel to open the Select Displays dialog box.

To add a display, double-click the icon.

To remove displays, do one of the following:

Select a display icon in the Selected Displays list, and then click Remove.

Double-click a display icon in the Selected Displays list.

Click the Close button in the upper right hand corner of the selected display.

You can mix displays from multiple application folders.

Common Information Messages
The following table lists some of the common information messages that might appear during normal operation.
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Table 2: Common Information Messages
Message Explanation and recommended action
Acq BW too small for current setup The display needs a wider acquisition bandwidth than the current data record

contains. This can be due to any of the following reasons:

A display other than the one you intended has been selected. The selected
display has requested a smaller acquisition bandwidth to achieve a better
accuracy or dynamic range for its particular measurement.

Select the display that contains the message. Click Run if the instrument
is not already acquiring data.

Acquisitions are not running and the measurement now requests a wider
bandwidth than the last acquisition.

Click Run to perform a new acquisition with a wider bandwidth.

The data is from a recalled file.
There is no way to increase the acquisition bandwidth for saved data. You
must adjust the measurement settings so that less bandwidth is required.

Need swept acq or larger Acq BW When any display requires a swept acquisition, the other displays are unable to
process the swept data. This is because the swept data is customized for the
selected display.

Select the display that you are interested in and the acquisition settings will
automatically change to meet the requirements of the selected display.

RBW increased to 100 kHz The current Spectrum Length or Analysis Length is not long enough to allow
a narrower RBW filter.

If the Length control is set to Manual, try increasing it or setting it to Auto so
that the Analysis Length will increase to the required value.

Changing Measurement Settings
The displays have settings that control how signals are acquired and processed. The settings that you can change depend
on the selected display.

To access the settings (in this case, for the Spectrum display):

1. Click Settings to open the Settings
control panel.

2. Adjust the controls as needed for your
signal or test. Most of the control panels
have tabs that provide easy access to
other related controls.
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Quick Tip
If you have multiple displays on the screen, click anywhere inside one of the other displays to change to the control
panel for that display.

Presetting the Instrument
You can preset the instrument to restore the setups to their default values.

1. To start with the default instrument
settings, push the Preset button on the
front panel or select Preset from the
Setup menu.

Quick Tip
Preset does not change any of the settings specified from the Config In/Out control panel or from the Tools menu, such
as GPIB address, Save/Export preferences, or the Auto Alignment setting.

Connecting a Signal
The spectrum analyzer has a single RF signal input located on the front panel. Make sure that you observe the input
signal requirements before connecting a signal to the input.

CAUTION. To prevent static damage to the instrument or to any instrument accessories, discharge to ground any
electrostatic charge that may be present on the center and outer conductors of cables, before attaching the cables to the
instrument inputs. Do not create an ESD (electrical static damage) antenna by leaving cables attached to the instrument with
the other ends of the cables open.
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Required Signal Levels
The following table shows the input signal levels over which the Real Time Spectrum Analyzer can be used for
measurements. The accuracy is guaranteed at a signal amplitude and frequency (normalization point). Measurements can
be made on signals within the entire range of allowable inputs, but the accuracy of the measurement is affected by the
frequency and amplitude of the signal to be measured (see the RSA6100A data sheet for more information).

RF Signal Input Range (CW or Peak Envelope Power)
Modulation Measurement Requirement Spectral Display Requirement
-50 dBm to +30 dBm DANL to +30 dBm

Input Signal Requirements
Characteristic Description
Input impedance 50 Ω
Input frequency range

RSA6106A
RSA6114A

9 kHz to 6.2 GHz
9 kHz to 14 GHz

Maximum measurable continuous input power 1 W (+30 dBm)
Maximum voltage rating ±40 V DC, AC coupled

CAUTION. To prevent damage to the instrument, do not connect CW signals greater than 1 Watt (+30 dBm). The maximum
voltage rating is ±40 V DC. The maximum pulse specifications are 75 W peak, 10 μs pulse width, 0.001 duty cycle, and
≥30 dB attenuation.

To connect an RF signal:

1. Connect the signal to the RF INPUT
connector on the front panel.

Quick Tip
If the source signal is greater than 1 Watt (+30 dBm), connect the source signal to an attenuator. Connect the attenuator
output to the RF Input connector.
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Starting and Stopping Acquisitions
1. Click the Run button to start an

acquisition.
While acquiring data, the button
label has green lettering.

2. Click the Run button again to stop
an acquisition. If an analysis is in
process, it will finish its sequence
and then stop. The button label
changes from green lettering to
black lettering to indicate that the
instrument has stopped.

Quick Tip
Push the front panel Run button to start and stop acquisitions.

Run Control
The Run menu provides access to commands that control the acquisition and the measurement sequence. Refer to
the online help for information on all of the Run menu selections. Continuous is the default selection. When you select
Continuous, the instrument will continuously acquire data until you stop the acquisitions. Select Single Sequence to run a
single acquisition every time you click Run or push the Run button on the front panel.

Markers
Use markers to measure time, frequency, power and other results. Markers measure absolute values and can also measure
the difference between markers.

Using Markers to Measure Frequency and Power
The following procedure shows how to use markers in the Spectrum display to measure frequency and power. The example
assumes that all markers are turned off and that a signal is on the screen.
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1. Click Markers to open the
Marker toolbar at the bottom of
the Analysis window.

2. Select Add Marker from the
drop-down list on the Marker
Toolbar.
The first marker is designated
the marker reference (MR).

3. Position the marker on the
screen using the arrow buttons in
the Marker toolbar. You can also
drag the marker to the desired
position using the touch screen
or the mouse.

4. Read the frequency and power
level from the marker readout on
the display.

Behavior
Rectangular markers show absolute values in the readout. The readout of the selected marker appears in the upper left
corner of the display and in the Marker toolbar.

Diamond markers show delta values (relative to the reference marker). The delta readout of the selected marker appears
in the upper right corner of the display and in the Marker toolbar.

When you drag markers along a trace with either the touch screen or the mouse, the marker will seek the high points.
The marker stays within 20 trace points of the mouse position. If there are no peaks within the current range of trace
points, the marker finds the highest point.

Quick Tips
If markers are turned off, click Peak in the Marker toolbar or on the front panel to add the marker reference (MR) and to
position it on the maximum peak level on the trace in the selected display.
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Click Table in the Marker toolbar to open a tabular display showing the marker information.

Marker Toolbar
The Marker toolbar has several controls to work with markers. (See Table 3.) Some of these controls are similar to those
on the front panel.

Table 3: Marker toolbar
Icon Description

Opens the Define Markers control panel. Use the control panel to add and
remove markers and to set marker parameters.
Sets the Measurement Frequency of the instrument to the frequency of the
selected marker. This button is only present when the selected display has
frequency on the horizontal axis.
Moves the marker to the maximum peak level on the trace. The maximum peak
can be either the highest or the lowest point in displays with both positive and
negative values on their vertical axis (such as Frequency Error or Phase).
Moves the selected marker to the next peak to the left of the current position.

Moves the selected marker to the next peak to the right of the current position.

Moves the selected marker to the next lower peak value. The peak value refers to
the absolute value of the peak amplitude. When repeatedly moving the marker, it
can move in any direction depending on the location of the next peak.
Moves the selected marker to the next higher peak value. The peak value refers
to the absolute value of the peak amplitude. When repeatedly moving the marker,
it can move in any direction depending on the location of the next peak.
Opens or closes the marker table in the display.

Adding Markers
You can have up to five markers. The first marker (MR) is a reference marker. The other markers (M1, M2, M3, and M4) can
show absolute values or can show both absolute values and the difference values between them and the reference marker.

To add another marker, select Add Marker from the drop-down list in the toolbar.

Defining Markers
Use the Define Markers control panel to define the marker settings.
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1. Click Define to open the Define Markers
control panel.

Use the control panel to:

Add or delete markers.

Turn markers off.

Assign markers to specific traces.

Set the marker readouts to absolute or
delta.

Define the threshold and excursion
values.

Quick Tip
You can add or delete markers from the drop-down list next to Define in the Marker toolbar.

Touchscreen Actions
You can use the touchscreen to change marker settings and how waveforms are displayed by using the Touchscreen Actions
menu. To use the Touchscreen Actions menu, touch the display and hold for one second, then remove your finger. You can
also use a mouse to display the Touchscreen Action menu by clicking the right mouse button.

Note that some selections in the Touchscreen
Actions menu are selectable only when a
marker is defined

Touchscreen Actions menu
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Table 4: Touchscreen Actions Menu
Icon Menu item Description

Select Selects markers and adjusts their position

Span Zoom Zooms the graph area about the selected point. Touch the graph display at a point
of interest and drag to increase or decrease the span about the point of interest.
Span Zoom adjusts the span control and can affect the acquisition bandwidth.

CF Pan Adjusts the Center Frequency according to horizontal movement.

Zoom Adjusts horizontal and vertical scale of the graph. The first direction with
enough movement becomes the primary scale of adjustment. Adjustment in the
secondary direction does not occur until a threshold of 30 pixels of movement is
crossed.
Dragging to the left or down zooms out and displays a smaller waveform
(increases the scale value). Dragging to the right or up zooms in and displays a
larger waveform (decreases the scale value).

Pan Adjusts horizontal and vertical position of the waveform. The first direction with
enough movement becomes the primary direction of movement. Movement in
the secondary direction does not occur until a threshold of 30 pixels of movement
is crossed.

— Reset Scale Returns the horizontal and vertical scale and position settings to their default
values.

— Marker to peak Moves the selected marker to the highest peak. If no marker is turned on, this
control automatically adds a marker.

— Next Peak Moves the selected marker to the next peak. Choices are Next left, Next right,
Next lower (absolute), and Next higher (absolute).

— Add marker Defines a new marker located at the horizontal center of the graph.
— Delete marker Removes the last added marker.
— All markers off Removes all markers.

Printing
You can print a copy of the screen and its contents (a screen shot) to a printer or a file.

1. Push the Print button on the front panel
or select Print from the File menu.
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2. Fill out the details in the Print dialog box,
and then click OK.
The Print dialog box is the standard
Microsoft Windows Print dialog box. The
printer controls are dependent on your
printer.

Saving Data
You can save different types of data for future use.

1. Select Save As. . . from the File menu
to open the Save As dialog box.

2. Navigate to the folder where you want
to save the setups, or use the default
location.

3. Enter a file name.

4. Select the type of file to save. (See
Table 5.)

5. Click Save.
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Quick Tips
Select File > Save or press the Save button to save the information to a file using the same name, path, and data type
as the last time that you saved. If the file already exists, the file name suffix number will increment if you previously
selected that option in the Tools > Options > Auto Filename control panel tab.

Select File > Save As to open the standard Windows Save dialog box where you can edit the file name, choose what
data type to save, and select a folder for storing the file.

Table 5: File Types for Save
File types Description
Setup files Saves all of the setup information for all settings displays, except those settings

that are specified under the Tools menu (Alignments and Options) or in the
Config In/Out control panel.

Results Export files Saves the trace and numeric data for the selected display. The trace and numeric
data are saved in CSV format as text files.

Picture (PNG/JPG/BMP) Saves a graphical representation of the screen in the specified format. This
option is useful for including the graphic in reports or other applications. Marker
readouts and other information are included.

Selected Trace Saves a trace for later recall back into the display from which it was saved.
Data (acquisition data and acquisition
data export)

Saves data for reanalysis by the RSA6100A Series Real-Time Spectrum
Analyzers or as CSV (comma-separated value) data to use with external software.

Recalling Data
You can recall acquisition data and setup files previously saved by the RSA6100A Series Real-Time Spectrum Analyzers.

1. Push the Recall button on the front panel
or select Recall from the File menu.

34 RSA6100A Series Quick Start User Manual



Operation

2. In the Open dialog box, browse to the
location of the file.

3. If you do not see the file, select the type
of file under Files of Type.

4. Double click the file name to load the file.

Quick Tip
If you recall a trace that has an x-axis range that doesn’t fall within the x-axis range of the current graph, the trace will not be
visible. A small arrow will point off-screen in the direction of the recalled trace. Use the Frequency and Span (or Span and
Offset) controls to bring the trace on the screen in the Spectrum display. In other displays, use Horizontal Scale and Offset
(which can also be used in the Spectrum display). These controls are on the Settings > Scale tab.

Advanced Techniques
Setting Up Triggering
The RSA6100A Series Real-Time Spectrum Analyzer offers real-time frequency domain triggering (option 02) in addition to
power-level triggers, line trigger, and external triggers. It uses a trigger event as a reference point in time for the seamless
acquisition of the signal. This allows the spectrum analyzer to store both pretrigger and post-trigger information.

The spectrum analyzer has two triggering modes:

Free Run mode. In Free run mode, the instrument initiates acquisitions without considering any trigger conditions. It
is a fast and easy way to see the signals. Free Run is usually adequate for the Spectrum display unless you need to
specify a particular time at which to collect the data record.

Triggered mode. In Triggered mode, the instrument initiates an acquisition when a trigger event is recognized. The
conditions that define a trigger event depend on the selected trigger source. There are several source selections available for
choosing the signal to monitor for a trigger event.

Once you select the Triggered mode, you must select the source. The trigger sources are:

RF Input

Trig In

Trig 2 In

Gated

Line
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Once you select the trigger source, you can set additional parameters to specify the trigger event. If you specify the RF Input
as the trigger source, you can chose from two trigger types:

Frequency Mask Triggering. Frequency Mask Triggering allows you to trigger the instrument when a signal in the
frequency domain violates the mask. You can draw a mask to define the conditions within the real-time bandwidth that will
generate the trigger event. It allows you to trigger on weak signals in the presence of strong signals. This triggering is
also useful for capturing intermittent signals.

Power Triggering. Power triggering triggers the instrument on time-domain signal characteristics. The incoming data is
compared to a user-selected level in dBm. You can select the time-domain bandwidth and trigger on the rising or falling edge.

In addition to defining the trigger event, you can define the following parameters by selecting the appropriate tab in
the Trigger control panel:

Time parameters that define where a trigger occurs within the acquired data record and whether to delay the trigger
for a set amount of time.

An Advanced parameter that triggers each segment in swept acquisition mode.

Accessing Trigger Parameters

1. Click Trig to open the Trigger control
panel.

2. As shown in the following steps, click
one of the tabs in the Trigger control
panel to define the trigger parameters.

3. Use the Event tab to set parameters that
define trigger events. The parameters
vary depending on the trigger Source
and Type selections.
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4. Use the Time tab to set parameters that
control the position of the trigger event.

5. Use the Advanced tab to select whether
to trigger on each segment in Swept
acquisition mode.

Quick Tip
Other ways to access the Trigger control panel:

Push the Trigger button on the front panel.

Select Trigger . . . from the Setup menu.
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Creating a Frequency Mask
Use the Mask Editor to create a Frequency Mask. The mask is a set of points defined by frequency and amplitude. Access
the Mask Editor from the Trigger control panel. (This procedure uses the Spectrum display.)

1. Click Trig to open the Trigger control
panel.

2. Select the Event tab in the control panel.

3. Set the Source to RF Input.

4. Set the Type to Frequency Mask.

5. Click Mask Editor to open the Mask
Editor.
The Mask Editor opens with the traces of
the Spectrum display in the graph.

6. Click New in the tool bar. This removes
the existing mask and then creates a
default 6-point mask.
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7. Click any point in the mask to select it.
The frequency and amplitude of the
selected point are highlighted in the
graph.

8. Edit the point by doing one of the
following:

Drag and drop the point with the
mouse.

Enter the frequency and amplitude
in the table.

Adjust amplitude with the up/down
arrow keys and frequency with the
left/right arrow keys.

Quick Tips
Right click on the display screen to add a new point.

Click Add Points and then click on the graph to add a new point in the graph.

Click Next to select the next point in the graph.

Click the X (delete button) to delete the selected mask point.

Click Save to save the mask file and continue working with the mask editor.

Click Open to load and edit a previously saved mask file.
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Defining Trigger Conditions
After you have set up the mask, you can select whether to trigger on the presence or absence of mask violations.

1. Select a condition.
The choices are described below. (See
Table 6.) The icons at the bottom of the
control panel identify what is considered
true or false.

2. Click Triggered.
The instrument will trigger when the
trigger conditions are met.

Table 6: Trigger Violations
Violation Description
T The instrument triggers whenever the signal violates the mask (above the line).
F The instrument triggers whenever the signal has no points in the mask.
T > F One transition defines the trigger event. The signal must go out of the mask (no

violation) after being inside of the mask (violation).
F > T One transition defines the trigger event. The signal must go into the mask after

being outside of the mask.
T > F > T Two transitions define the trigger event. The signal must start inside of the mask,

cross outside of the mask, and then cross back into the mask.
F > T > F Two transitions define the trigger event. The signal must start outside of the mask

(no violation), cross into the mask, and then cross back outside of the mask.

Controlling Acquisitions
When two or more displays are open, one display controls the acquisition system. The acquisition requirements for the
selected display set the acquisition hardware parameters. While the acquisition parameters are optimized for the selected
display, they might not be ideal for other displays. In this case, the other displays might be unable to maintain optimum
performance and consequently might be unable to produce results. (This also happens when analyzing recalled data:
measurements attempt to deliver results, but may not be able to comply with all their settings.)

You can specify which display controls the hardware acquisition parameters by clicking anywhere in that display. When there
are multiple displays, the highlighted display controls the hardware acquisition parameters.
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In this example, there are two displays, a
Spectrum display and a DPX Spectrum
display. The highlighted title bar on the DPX
Spectrum display indicates that it is the
selected display.
The check mark indicator in the upper
left corner of the display indicates that
acquisition hardware is optimized for the
Spectrum display.

Some displays do not control the acquisition hardware. These displays just show the captured data. Some displays share
the same parameters. If any of one of these displays in such a family controls the acquisition hardware, then the acquisition
parameters are optimized for all of the displays in that family.
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Measurements with Conflicting Acquisition Requirements
The RSA6100A Series Real-Time Spectrum Analyzer lets you open any combination of measurements. You can select
the displays that you are interested in and the instrument will automatically set up the appropriate analysis and acquisition
parameters.

If measurements place conflicting requirements on the acquisition parameters, the current selected display takes priority. The
following example shows incompatible measurement settings when one display needs real-time data (such as the Amplitude
vs Time measurement) while another display requires swept data (such as a Spectrum graph with a very wide span).

1. Push the Preset button on the front
panel to set the instrument to the default
settings.

2. Tune the instrument to the frequency of
your signal and then set the span.

3. Click Displays to open the Select
Displays dialog box.

4. Select the General Signal Viewing folder.

5. Select the Amplitude vs Time icon.

6. Click Add to add the icon to the Selected
Displays list.

NOTE. Add the Spectrum display if it is not
already in the Selected Displays list.

7. Close the dialog box.
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8. Click Run to start acquiring data.

9. Increase the span in the Spectrum
display to 200 MHz.
Because Spectrum is the selected
display, the acquisition parameters
adjust automatically to meet the needs
of the display. The 200 MHz span
exceeds the real-time bandwidth of the
instrument. As a result, the instrument
will change to swept mode.

10. Look at the Status bar. The readout
“Swept” indicates when acquisitions are
swept.
When the acquisitions are in “Real Time,”
all measurements usually run. If the
acquisitions are swept, only the selected
display can run.
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11. Click the Amplitude vs Time display to
make it the active display.
The acquisition switches back to
real-time because the selected display
requires real-time. The data is now
suitable for the Amplitude vs Time
display but doesn’t contain the full range
of frequencies needed by the Spectrum
display.
In this case, the Spectrum is unable to
run.

12. Decrease the span to 40 MHz in the
Spectrum display. Now the acquisitions
are real-time again.

13. Check the status bar readout to verify
that the acquisition is real-time.
Both of the displays can run now.

Searching Signals
The RSA6100A Real-Time Spectrum Analyzer lets you search signals for changes in power level. You can identify matches
as crossing a power level or you can create a mask that specifies power level and frequency range limits. You can select
which trace to search and specify an action to take when a search match occurs.
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To search a trace:

1. Open the Spectrum display or select the
Spectrum display if it is already open.

2. Select Tools > Search.

3. Select the Enable Search check box.

4. Select the trace you wish to search from
the Search in drop-down list box.

5. Verify that the trace you selected in the
Search in list is the selected trace and
that the Show box is checked.
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6. Specify what to search for by making a
selection from the Search for drop-down
list.
To search for signal levels above or
below a specified level, select either is
greater than or is less than.
To search for signal levels that vary with
frequency, select either is outside mask
or is inside mask. To specify the limits
in the search mask, click the Edit limits
button.
The orange shaded area in the graph
display shows the levels which, if
occupied by the signal, will constitute a
match.

Display with greater than search selected

Display with outside mask search selected
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7. Click the Actions tab to specify what
actions the spectrum analyzer should
take when a match occurs.
The spectrum analyzer can take up
to five actions when a match occurs,
depending on the run mode. In Run
mode, the spectrum analyzer can
sound a beep, stop acquisitions, save
acquisition data, save trace data, and
save a picture of the display. In Replay
mode, it can sound a beep and stop
analyzing.

8. To have the spectrum analyzer take an
action when a match occurs, select the
desired action.
You can select any combination of
actions to perform on a match. If you
select all actions, they will all occur when
a match is found (in Run mode).

9. Click the close box to remove the Search
control panel.

10. Press the RUN button to initiate a
search.
Red lines appear in the graph display
when there is a match on incoming data.
Click the Replay button on the toolbar
to initiate a search on the current data
record.

Using Correction Tables
The RSA6100A Real-Time Spectrum Analyzer lets you correct the signal displays and measurement results to account
for gains and losses in external equipment. You can specify a single gain value or you can use an external loss table to
adjust the gain/loss value based on frequency.
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To specify external gain/loss corrections:

1. Press the Ampl button to display the
Amplitude control panel.

2. Select the External Gain/Loss Correction
tab.

3. To apply a constant correction factor,
select the External Gain value check
box. Enter a value into the text entry box.

NOTE. You can enter either positive or
negative gain values. Positive values
represent a gain. Negative values represent
a loss.

4. To use a table that corrects for gain/loss
values depending on frequency, click a
check box under External Loss Tables.
You can enable all three external loss
tables at the same time. Thus, you could
use different external loss tables for an
antenna, a preamplifier, and for cabling.

5. To edit the contents of an external loss
table, click the Edit button for the table
you want to edit.
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6. Edit the contents of the table to match
the loss characteristics of the equipment
you are correcting for. Click OK when
you are finished.

NOTE. You can enter either positive or
negative values into the table. But in contrast
to the External Gain value setting, positive
values represent a loss and negative values
represent a gain.

For detailed information on using the Table
Editor, select Help > User Manual and look
in the Index for External Loss Tables.

7. You can change the title for each external
loss table. Select the title box and type
in a new title.
Note that the title is only a label. It is
not tied to the file name of any table you
have loaded or saved.

8. Click the close box to remove the
Amplitude control panel when you are
finished making changes.

Using Audio Demodulation
The RSA6100A Real-Time Spectrum Analyzer can demodulate audio signals which can help you to identify unknown radio
signals. You access the Audio Demod tab from the Settings control panel of the DPX Spectrum display.
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To demodulate an audio signal:

1. Press the Displays button to display the
Select Displays dialog box.

2. Select the General Signal Viewing
folder.

3. Double-click the DPX Spectrum icon to
add it to the Selected Displays list.

4. Click OK to close the dialog box. The
DPX Spectrum display will open.

5. Press the Settings front-panel button
to display the DPX Spectrum Settings
control panel.

6. Click the Audio Demod tab to display
the Audio Demod control panel.

7. Click the On button to enable audio
demodulation.

8. To specify the demodulation type, click
either the AM or FM button.

NOTE. Note that the AM and FM buttons
select only the demodulation type; they do
not specify a frequency band.

9. Set the center frequency as needed.
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The receiver frequency (frequency to
be demodulated) is specified with either
markers or the frequency control (the
front panel Frequency button or the Freq
control in the toolbar). Use the Tune with
setting to specify whether markers or the
frequency control is used to specify the
receiver frequency.

10. Select either a marker or frequency
control from the Tune with drop-down
list.

11. If the marker you select is not enabled
(it will be visible in the display if it is
enabled), click the Markers button in the
toolbar to display the Markers toolbar.

12. Click the Define button in the Marker
toolbar to display the Define Markers
control panel.

13. Click Add to add markers as needed.
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14. Click the Settings button to return to the
Audio Demod control panel.

15. Set the required receiver bandwidth by
entering a value into the Receiver BW
value entry box.

16. Set the receiver frequency.
If you specified a marker with the Tune
with setting, drag the marker to the
required frequency. Fine tune the marker
position with the front-panel knob or
your mouse wheel. If you selected
Frequency control in the Tune with
setting, press the front-panel FREQ
button, then turn the front-panel knob or
use the Freq setting in the toolbar to set
the required frequency.
The receiver frequency is displayed as
Receiver Freq between the Tune with
and Receiver BW settings.

17. Adjust the Audio Gain setting so you can
hear the demodulated signal. Note that
the sound level is also affected by the
setting of the Windows volume control.
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This section provides examples of typical applications using the spectrum analyzer. Each example requires that the
instrument to be powered on and connected to a signal. Your signals might be different from the ones shown in the examples.
As a result, you need to modify the instrument settings to view your signal.

NOTE. Some of the examples are based on saved acquisition data files. The setup files are located in the C:\RSA6100A
Files\Sample Data Records folder. You can load these files from the File > Recall menu to step through the following
applications.

Modulation Analysis
The RSA6100A Real-Time Spectrum Analyzer lets you analyze signals in many different ways without needing to reacquire
the signal. The following example shows how to use the RSA6100A Real-Time Spectrum Analyzer, with Option 21
installed, to demodulate a QPSK signal and to analyze the signal in multiple domains. This example shows you how to use
the instrument to do the following:

Demodulate a QPSK signal to show its constellation diagram.

Measure the EVM (Error Vector Magnitude) and other key indicators using the Signal Quality display.

View the phase of the signal in the time domain.

Use markers to show the correlation of results across the Symbol Table display, Constellation display, and the Phase vs
Time display.

NOTE. The following examples were based on the QPSK sample data file. If desired, you can load the QPSK sample data
file (the file name is QPSKDemo.tiq) to recreate the steps used in this application. The signal settings in the following
examples were based on the signal in the sample file. If you use a live signal, your settings may differ.
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Demodulate the Signal

1. Push the Preset button on the front
panel to set the instrument to the default
settings.

2. Tune the instrument to 2.13 GHz and set
the span to 20 MHz.

3. Click Displays to open the Select
Displays dialog box.

4. Select the General Signal Viewing folder.

5. Select the Time Overview icon.

6. Click Add to add the Time Overview icon
to the Selected Displays list.

7. Select the GP Digital Modulation folder.

8. Select the Signal Quality icon.

9. Click Add to add the icon to the Selected
Displays list.

10. Repeat steps 8 and 9 for the Constellation
icon, and then close the dialog box.
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The General Purpose Digital Demodulation displays share the same modulation and advanced parameter controls. These
controls are available in the Settings control panel of each display.

11. Select the Signal Quality display and
then click Settings.

12. Select the Modulation tab.

13. Set the Modulation Type to QPSK.

14. Set the Symbol Rate to 3.84 MHz.

15. Set the Measurement Filter to
RootRaisedCosine.

16. Set the Reference Filter to
RaisedCosine.

17. Set the Filter Parameter to 0.220.

18. Close the control panel.

Analyze the Signal
You can analyze the signal using both qualitative and quantitative methods.

This text needs to be rewritten to match the
new screen capture.
The Constellation display should look similar
to the illustration. For a QPSK signal, the
points should be located in four tight clusters.
If not, check your settings for Frequency,
Modulation Type, Symbol Rate, and Filters.
Look at the trace in the EVM vs. Time
display. The graph shows the EVM value in
percent at each trace point in time. The RMS
value for EVM during the entire analysis
period is shown at the bottom of the display
window, along with the peak EVM value and
the time (or symbol) at which it was detected.
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Manually Adjust the Analysis Length
The Time Overview display shows the entire acquisition record, illustrating the length and offset for Spectrum Time and
Analysis Time. The spectrum length is the period of time within the acquisition record for which the spectrum is calculated.
The analysis length is the period of time within the acquisition record where other measurements are made. The analysis
length can be automatically determined by measurement parameters such as symbol rate, or you can manually adjust
the analysis length.

NOTE. The Spectrum Length and Spectrum Offset cannot be set independently unless the Spectrum Time Mode is set
to Independent. You can change the Spectrum Time Mode on the Analysis > Spectrum Time control panel tab. The red
line that represents the Spectrum Time settings in the Time Overview display is only shown when the Spectrum Time
Mode is set to Independent.

1. In the Time Overview display, select the

Analysis Length button ( ). (Check
that acquisitions are running by verifying
that the RUN button is lit.)
The analysis length is indicated by the
blue bar above the graph.

2. Increase the analysis length. You can
do this by either changing the value in
the number entry box or by dragging the
right edge of the unshaded area.
Changing the Analysis Length setting
changes the amount of data used for
computing the measurements in the
displays. The shading in the display
shows the extent of the analysis period.
The increased analysis length causes
the instrument to automatically increase
the acquisition length setting to collect
enough samples to satisfy the new
analysis settings. By default, the
automatically determined Acquisition
Length is equal to or slightly greater than
the Analysis Length.
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3. Select the Analysis Offset button ( ).

4. Increase the Analysis Offset setting. You
can do this by either changing the value
in the number entry box or by dragging
the left edge of the unshaded area.
If the analysis offset is increased such
that the analysis period extends past
the end of the acquisition record, the
instrument automatically increases
the acquisition length to provide the
additional data.
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5. Change the Analysis Offset setting to
20μs.

6. Click Run to stop the acquisitions.

7. Increase the analysis offset again.
Because the instrument is stopped, it
can’t run a new acquisition to capture a
longer data record. When the requested
analysis period extends past the end
of the data record, the actual analysis
length is reduced.
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Capturing Transient Signals
The RSA6100A Series Spectrum Analyzer can identify infrequently-occurring transient signals and low-power signals that
may be obscured by stronger signals. After you find that these signals exist, you can use some of the following tools to
capture and examine the signal details to determine the cause:

Use the Max Hold function to verify the presence of signals other than the CW signal.

Use the DPX Spectrum display to view transient signals.

Create a frequency mask and the use the Frequency Mask trigger to capture any signal that violates the mask.

Use the Spectrogram with Frequency Mask Trigger to view the mask violations in the Time and Frequency domains.

Viewing Transient Signals in the Spectrum Analyzer Display
For traditional spectrum analyzers to show an accurate representation of a signal, the signal must be present and stable
during the entire sweep (capture time). However, some transient signals can cause interference so infrequently that they
might seem impossible to detect and capture with traditional spectrum analyzers. The RSA6100A Series Spectrum Analyzer
has several tools to help you see these transient signals.

NOTE. To complete these examples, you will need a signal with transients. A free source of transient signals can be found
by looking at off-air signals of radio transmitters using a simple antenna on the input of a spectrum analyzer. The cellular and
ISM (Industrial, Scientific, Medical) bands contain many signals. The ISM band is at 2.45 GHz for most countries.

1. Push the Preset button on the front
panel to set the instrument to the
default settings.

2. Tune the instrument to the desired
frequency and adjust the span to view
the signal on the screen.

3. Click Settings.

4. Select the Traces tab.

5. Make sure that Trace 1 is selected
and that Show is selected.

6. Select +Peak.

7. Select Max Hold.
Max Hold is the maximum amplitude
for the frequency data point across all
included traces.

8. Close the control panel.
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Over time, if a transient signal occurs, the Max Hold trace will show its presence.

Detecting Transient Signals Using the DPX Spectrum Display
The DPX Spectrum display uses a bitmap image in addition to line traces to view signals. Bitmaps can represent multi-value
signals so that you can see low-level and higher power signals that occur at the same frequency, but at different times.

1. Push the Preset button on the front
panel to set the instrument to the
default settings.

2. Click Displays.

3. Select the General Signal Viewing
folder.

4. Select the DPX Spectrum icon.

5. Click Add to add the application to the
Selected Displays list.
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6. Select the Spectrum icon in the
Selected Displays list.

7. Click Remove to clear the icon from
the list.

8. Close the dialog box.

9. Tune the instrument to the signal.

10. Adjust the span.

11. Select Enable +Peak Trace from the
drop down menu. This new trace
detects the highest peaks in each DPX
frame.

12. Click Settings to open the DPX
Spectrum Settings control panel.

13. Click the Traces tab.

14. Select Hold from the Function list to
hold the peaks from all acquisitions.

15. Close the control panel.

Quick Tip
Click Clear located just above the graph to clear the display and start collecting points again.

The Max Hold function shows the highest points collected over continuing updates. While the +Peak Trace shows the
highest points, it doesn’t show signals that are below the maximum value at any frequency. However, this is possible
with the DPX bitmap trace.
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16. Select Bitmap from the Trace Selector.

17. Click Settings to open the DPX
Spectrum Settings control panel.

18. Click Dot Persistence.

19. Increase the Persistence time.

The more you increase the Persistence
setting and the Intensity setting, the more
quickly you will see infrequent signal events.
In this example, the more frequent signals
appear in red; infrequent signals will appear
in blue.
These settings can also be used to display
signals below the maximum signal level. For
example, a low-level signal in the presence
of a pulsed signal might require a lower
Persistence and Intensity setting.
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Frequency Mask Triggering
If your instrument has Option 05 installed, you can use the Mask Editor to create a frequency mask for triggering on transient
signals. Complete the following steps to get a good visual reference that you can use to build the frequency mask.

1. Push the Preset button on the front
panel to set the instrument to the default
settings.

2. Tune the instrument to the frequency of
your signal.

3. Adjust the span.

4. Click Settings to open the Settings
control panel.

5. Select the Traces tab.

6. Select Trace 1 (make sure the Show
check box is checked).

7. Set the Detection to +Peak.

8. Set the Function to Max Hold.

9. Close the control panel.
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10. Click Trig to open the Trigger control
panel.

11. Set the Type to Frequency Mask.

12. Click Mask Editor to open the Mask
Editor.

13. Use the Mask Editor to create a mask for
your signal. (See page 38, Creating a
Frequency Mask.)
Traces that you selected in the Spectrum
Analyzer display are used as references
in the Mask Editor. All trace detections
and functions are available.

14. Close the Mask Editor.

15. Select the condition that you are
interested in.
For example, if you want the instrument
to trigger when it detects the first violation
after seeing at least one acquisition with
no violations, select the F > T violation.
(A violation is when any point is within
the shaded mask line.)

16. Click Triggered.
The instrument should trigger when
a violation occurs. If you believe that
the instrument might have triggered
prematurely (on noise instead of a real
violation), then you may need to adjust
your mask.
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Viewing Transient Signals in Time and Frequency Domains
Spectrograms allow you to see how signals change over time. You can use the Spectrogram display to examine the transient
signals that violated the mask. Combining the Spectrogram display with the Frequency Mask Trigger allows you to see
how often the violations occur and to troubleshoot the cause of the problem.

1. Click Displays to open the Select
Displays dialog box.

2. Add the Spectrogram and Time Overview
displays.

3. Close the dialog box.
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4. Select the Time Overview display.

5. Increase the Analysis Length setting until
the Time Overview display covers the
transient signal.

The Spectrogram display shows an example
of a transient signal. As you increase the
Analysis Length setting, the number of
spectrogram lines within each acquisition
also increases.
The marks along the right side of the
Spectrogram display show the beginning of
each acquisition record.

The Spectrogram display shows both time and frequency domains in a single display. The vertical axis is time, with newer
data at the bottom. The horizontal axis is frequency, covering the same span as the Spectrum display.
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1. Click Markers to open the Marker
toolbar.

2. Select Add Marker to add one marker
to the display.

3. Select the Spectrum display by clicking
the title bar.

4. Make sure the checkbox for Spectrogram
Trace in the Spectrum display is checked.

The Spectrogram trace in the Spectrum
display corresponds to the line selected
in the Spectrogram display by the active
marker.

NOTE. If there is no active marker, the
Spectrogram trace in the Spectrum display
shows the bottom line from the Spectrogram
display (adjusted by the vertical Offset
control).

Quick Tip
Spectrum traces 1, 2, 3, and 4 show the spectrum for the Spectrum Time selected in the Time Overview display or in the
Spectrum Time tab of the Analysis control panel. The Spectrogram, by comparison, covers the Analysis Time selected in
the Time Overview display or in the Analysis Time tab of the Analysis control panel.
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Pulse Measurements
Pulsed RF measurements have historically been difficult to perform. Some measurements required custom-built and
dedicated test tools. These custom-built tools required trained experts to properly use the tools to achieve accuracy and
repeatability. Tektronix real-time spectrum analyzers have revolutionized taking pulse measurements through automation. An
RSA6100A Series Spectrum Analyzer, with Option 20 installed, can replace specialized test equipment formerly required for
pulsed RF measurements.

This application shows how to accomplish the following pulsed RF measurements:

Capture a series of RF pulses in a single acquisition record.

Select measurements to display in a pulse table.

Examine the pulse shape and measure reference points with the Pulse Trace display.

View Trend and FFT analysis on the measurement results with the Pulse Statistics display.

NOTE. To complete the following example, you will need a pulsed signal or an appropriate saved data record. This example
uses the PulseDemo.tiq file, which is located in the folder C:\RSA6100A Files\Sample Data Records.

Capture the pulses

1. Push the Preset button on the front
panel to set the instrument to the default
settings.

2. Adjust the instrument controls to view
the waveform on the screen.

3. Click Displays to open the Select
Displays dialog box.
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4. Select the General Signal Viewing folder.

5. Select the Time Overview icon and add
the application to the Selected Displays
list.

6. Select the Pulsed RF folder.

7. Add the Pulse Table and Pulse Trace
displays to the Selected Displays list.

8. Click OK to close the dialog box.

9. Set the Frequency to 2.7 GHz.

10. In the Time Overview display, set the
Analysis Length to include several
pulses.
Only complete pulses are recognized.
Complete pulses are defined as pulses
from the rising edge of one pulse to the
rising edge of the next pulse.
For example, the last pulse within the
highlighted area is not a complete pulse
because the second rising edge is not
within the measurement area.
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11. Select the Pulse Table display and then
select Settings.

12. Select the Measurements tab.

13. Select the measurements that you are
interested in. (For this example, select
Average ON Power, Pulse Width, and
Rise Time).

14. Close the control panel.

15. When you see the data in the Pulse Table
display, click Run to stop acquiring data.

Quick Tip
You can take measurements while the instrument is running or while it is stopped. Stopping the instrument may make it
easier to read the measurements from already captured data.

Measure the Parameters of the Captured Pulses
After you have captured the pulses, you can use the Pulse Trace display to view the details of specific measurements.
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1. Select one of the measurement results
in the Pulse Table display. For example,
click the cell for the Width measurement
of Pulse 1.

The Pulse Trace display shows an
amplitude versus time trace for the
selected result on the selected pulse.
Blue lines and arrows show how the
measurement was made.
The green arrow in the display shows the
power threshold used to detect pulses. If
this threshold is set too high or too low,
no pulses will be detected. You can set
the power threshold on the Settings >
Params tab.

2. Click the Pulse control in the Pulse
Trace display and enter a different pulse
number.
The new pulse appears in the Pulse
Trace display and is selected in the
Pulse Table display. You can use the
Pulse Trace display and the Pulse Table
display together to view and analyze
pulse measurements.
You can select a different result in the
Pulse Trace display and it will also be
selected in the Pulse Table display.

3. Use the Scale and Offset controls to
zoom in on details of the selected pulse.
For example, you can adjust the controls
to get a close look at the details of the
Rise Time measurement as shown.
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Quick Tip
Click Autoscale to optimize the vertical and horizontal offset and scale settings.

When using scale or offset, adjust the offset control to move the area of interest to the far left side of the screen,
and then adjust the scale to expand the area of interest.

Review Measurement Statistics Across all Measured Pulses
You can use the Pulse Statistics display to show the trend or an FFT across all measured pulses. To get the best frequency
resolution and dynamic range in the display, you need to include many pulses in the analysis period.

1. Set the Analysis Length in the Time
Overview display to 19 ms. Set the
Analysis Offset to 100 µs.

2. Click Displays to open the Select
Displays dialog box.

3. Select the Pulsed RF folder.

4. Remove the Spectrum icon and the
Time Overview icon from the Selected
Displays list.

5. Add the Pulse Statistics icon to the
Selected Displays list.

6. Close the dialog box.
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The Pulse Statistics display plots the
results of the selected measurement for
every measured pulse.

7. Select the Phase measurement.
Pulse-to-pulse phase measurements are
good examples to show the trend and
FFT statistics.

8. Change the Statistics trace to FFT.

FFT shows a spectrum-like trace of the
amplitude (in dB relative to the highest
result in the set) vs frequency. This can
be useful for identifying interference in
the pulsed signal. For example, if a spike
appears around 60 Hz, it might indicate
coupling from the AC power supply.
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A
Accessories

documents, 1
optional, 2
power cords, 1
standard, 1

Acquisition
conflicts, 42
controlling, 40
data source, 22
starting, 28
stopping, 28

Analysis length, 56
Analysis offset, 57
Analysis window, 21, 23
Applications, 53

capturing transient signals, 59
modulation analysis, 53
pulse measurements, 68

audio demodulation, 49

C
CF Pan

Touchscreen actions menu, 31
check mark indicator, 19, 40
Cleaning procedures, 11
Conflicts

measurement, 42
Connectors

front panel, 16
rear panel, 17
RF signal input, 26, 27

Constellation display, 55
Controlling acquisitions, 40
Controls

display-specific, 20
front panel, 13
interface, 17

Cooling clearances, 3
correction tables, 47

D
Data

recalling, 34
saving, 33

Default settings, 26

Diagnostics, 10
Digital demodulation displays, 23
Display

conflicts, 42
Display properties

changing, 8
Display settings

changing, 25
Displays

Constellation, 55
DPX Spectrum, 60
general signal viewing, 23
GP Digital Modulation, 23
printing, 32
Pulse Statistics, 72
Pulse Trace, 70
Pulsed RF, 23
RF measurement, 23
selecting, 24
Signal Quality, 55
Spectrogram, 65
Time Overview, 56

Documentation, vi
Tektronix part numbers, 1

DPX Spectrum display, 60

E
Environmental specifications, 3

altitude, 3
cooling clearances, 3
humidity, 3
temperature, 3

EVM, 55
Extended desktop, 5
external gain/loss correction, 47
External monitor, 5

F
Features, vi
File types, 34
Free Run trigger mode, 35
Frequency mask

Mask Editor, 38
triggering, 36, 63

Front panel
connectors, 16
controls, 13

G
General signal viewing displays, 23
Graphics driver, 8

I
Incoming inspection, 10
Information messages, 24
Input requirements

frequency range, 27
input impedance, 27
power, 27
RF signal range, 27
voltage, 27

Installation, 1
network connections, 4

Italicized numbers, 20

K
Key features, vi

M
Maintenance

cleaning procedures, 11
repackaging, 11

Marker toolbar, 30
Markers, 28

absolute, 29
adding, 30
defining, 30
delta, 29
shapes, 29

Mask Editor
adding points, 38
editing points, 39

Max Hold, 59, 61
Max Trace, 61
Measurement

conflicts, 42
Mechanical specifications, 3
Messages

on-screen, 24
Modulation analysis, 53

N
Network connections, 4
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O
Optional accessories, 2
Options, 2

Power cords, 1

P
Pan

Touchscreen actions menu, 31
Part numbers, manuals, 1
Power cord options, 1
Power level triggering, 36
Power supply, 3
Preset, 26

system settings, 26
Printing, 32
Product features, vi
Pulse measurements, 68
Pulse Statistics display, 72
Pulse Trace display, 70
Pulsed RF displays, 23

R
Real-Time spectrum analyzer, 21
Rear panel connectors, 17
Recalling data, 34
Repackaging, 11
Reset scale

Touchscreen actions menu, 31
Returning the instrument, 11
RF measurement displays, 23
RF signal connections, 26, 27
RF signal input range, 27
Run control, 28
Run menu, 28

S
Safety Summary, iii
Save options, 34
Saving data, 33

Screens, printing, 32
Search, 44
Select

Touchscreen actions menu, 31
Selected window, 40
Selecting displays, 24
Settings

changing, 25
default, 26
preset, 26

Setups
recalling, 34
saving, 33

Signal Quality display, 55
Software upgrades, vii

installing, 11
Span Zoom

Touchscreen actions menu, 31
Specifications

altitude, 3
cooling clearances, 3
environmental, 3
humidity, 3
input requirements, 27
mechanical, 3
power supply, 3
product dimensions, 3
temperature, 3

Spectrogram display, 65
Spectrum analyzer

real-time concepts, 21
Spectrum length, 56
Standard accessories, 1

documents, 1
power cord, 1

Starting acquisitions, 28
Stopping acquisitions, 28

T
Time Overview display, 56
touchscreen actions menu, 31

Transient signals, 59
Trigger

control panel, 36
mask, 38
violations, 40

Trigger Event parameters, 36
accessing, 36

Triggered trigger mode, 35
Triggering

free run, 35
frequency mask, 36, 63
parameters, 36
power level, 36
triggered, 35

U
Upgrades

software, vii, 11

V
Violations

trigger mask, 40

W
Window

analysis, 21
selected, 40

Z
Zoom

Touchscreen actions menu, 31
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